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Preface

Computer

: Computers, a series of eight books, is a carefully arranged Computer series,

that perfectly complies with the NCERT syllabus criteria and the National
Curriculum Framework's vision. In auordance with NEP 2020’s guidelines,
the series adopts an interactive approach to make Learning about
Computer enjoyable for students. This book includes enough questions in
accordance with the NEP criteria. The fundamental principles of NEP which
are recognising, identifying and fostering the unique capabilities of each
student, respect for diversity, and respect for the local context in all topics,
are always kept in mind while creating the book.

The topics are introduced in a way that children experience and learn
through exploration.

Child-friendly language and contextual images have been incorporated
throughout the series to make the material more understandable for young
readers. This allows them to connect what they read and relate it to the
views, ideas and experiences they encounter every day.

Salient Features of the series:
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COMPUTER LANGUAGE

©.| | [Learning/Outcomes

At the end of this lesson, students will be able to:

+ Comprehend programming language.

+ Learn about types of programming languages.

+ Know the history and development of programming languages.

We use different modes to communicate. Can you guess their names?

= | | |

«@ Teacher’s Apprise students that humans have the ability to communicate and share information. The

2\} Note:

simplest form of human-to-human interaction is possible only with the help of language
that people understand. Now, introduce to them that to communicate with a computer, we
need a language that the computer understands.
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Hello, Friends! We use language
to express our views and feelings.
Let us learn the language which
the computer understands.

You are in the kitchen, and your mother instructs you to make Pasta. You can easily
understand the instructions because your mother is using a language that you understand.

Similarly, we need alanguage that a computer understands to communicate with a computer.
For every action, a computer has to be given instructions carefully.

A user inputs instructions into a computer’s memory using a language which the computer
can comprehend. In other words, a program consists of instructions written using a specific
programming language.

Instructions

Program

Software

= Computer-6
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Similar to how people communicate
with one another using different
languages, we may also use
different programming languages
to write instructions for a computer
program. Let us learn about
Programming.

A program is a set of instructions that tells the computer what to do. The process of writing
a set of instructions that tells the computer how to input, process and output data is called
programming.

To create a program, we need to learn a programming language. Some popular programming
languages are listed below.

C C++ Java Python
Ruby Perl Scala SQL
C# Swift R PHP

. = Do You Know?

C++ was actually referred to as “The New C.” This is because C++ draws inspiration from C, building
upon its framework while adding new features and functions to the language.

HISTORY AND DEVELOPMENT OF PROGRAMMING LANGUAGES

The development of computer languages have been classified into the following categories.
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Programming Languages

|
()

(First Generation)- A computer is an electronic device that can only understand electronic
signals. This language is expressed in binary form, i.e., 0 and 1, where 0 means ‘oft’; this is to
signify a stage where the current is not flowing in the electronic computer units. The other
stage is 1, the ‘on’ stage, which signifies the current flowing within the computer circuit.

[ ]
i )i (i)

Machine Language

This language has very high speed and very low memory <
utilisation. But understanding it is difficult and a bit time- Mt UELIEIT,
consuming. It is highly dependent on the machine, which is why | What do you mean by
it is also regarded as a Low-Level Language. low-level language?

Assembly Language

(Second Generation) - Symbols or mnemonics codes

are used in this language in place of 0 and 1. For

example, if you want the computer to add two numbers,

the mnemonics used for performing this task would

be ADD. The assembly language programs have to

be converted into machine language using translator  Figure 1.1 First Generation Computer
programs known as Assemblers since a computer can

only understand machine language.

High-Level Languages

(Third Generation) - People created a language due
to limitations placed on using machine and assembly
languages with the following features.

< User-friendly.

g 1
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Almost all modern programming languages follow the
standard of higher-level languages. The syntax of higher-level
languages is similar to our English Language, which is easier
and simpler than assembly and machine languages.

All modern computers need a Translator to convert

a higher language code to machine language code.

Translator programs are of two types:

1. Interpreter: This translator program converts
programming code written in a higher-
level language into machine language. An
interpreter translates line by line, carries out
the instructions and then repeats the procedure  Figure 1.3 Third Generation Computer
for the remaining instructions.

Interpreter ~ programs  are WadAvAYI=1AzWAM

preferred for beginners and are | A gpecialised language called Sql is used to
slow in execution speed. update, delete, and extract information from

2. Compiler: A compiler is a | databases.
translator program that converts
programming code written in high-level
languages into machine language. A compiler
scans the whole code and converts the code at
once.

Fourth-Generation Language (4GL) - Most fourth-
generation languages are based on Structured
Query Languages. This language is a combination
of languages with the following features.

1. High speed of execution. Figure 1.4 Fourth-Generation Computer

2. Highly user-friendly and designed to reduce the level of programming efforts.

3. In this language, the user has to mention only the
required output, while the computer regulates the
sequence of instructions that will fulfil those results.

Fifth Generation Languages (5GL) - The fifth-generation
languages aim to provide an automated solution. It will
look for an algorithm to solve any given problem and
then automatically carry out the algorithm to solve that
problem. Figure 1.5 Fifth-Generation Computer
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Generation Popular Programming Languages

First Generation Languages Machine Language

Second Generation Languages FORTRAN, COBOL and ALGOL

FORTRAN, Pascal and the C-family C++,

Third Generation Languages C#, Objective-C

Fourth Generation Languages Perl, Python, Ruby, SQL, MatLab

Fifth Generation Languages Mercury, Prolog, OP55

Advantages of Learning Programme

1. Reasoning Skills: Programming demand solving complex problems. In programming,
we learn how to breakdown a large problem into smaller problems and how to solve
each of them. This strategy aids in the growth of our reasoning skills.

2. Enhances Creativity: Making something new from scratch is what programming is all
about, and this requires creativity.

3. Develop Analytical Thinking: Analysis is the initial stage
in problem-solving. Understanding complicated issues
and producing simple solutions to them is the core goal of
programming. This necessitates a thorough examination of
the issue at hand.

@ Let me Answer

What do you mean by
creativity?

%S Kids’ 1Q

Saurabh’s great grandmother was a programmer in the third generation of computer
language. What kind of language did she use at that time?
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’ Let’s Recall

The process of writing a set of instructions that tells the computer how to
input, process and output data is called programming.

Machine language is highly dependent on the machine.
The syntax of higher-level languages is similar to our English Language.
Fourth-generation languages are based on the Structured Query Language.

The fifth-generation languages aim to provide an automated solution.

> Upskill Your Intelligence =

A. Fill in the blanks

1.

5.

A program consists of instructions written using a specific ....................
language.

A computer is an electronic device that can only understand ........................ :
Machine language is highly dependent on the ............................
.................... codes are used in the Assembly languages.

In binary language, 0 means ...................... and 1 means ...........cccccoceucs :

B. Match the following.

1.

2.

3.

First Generation Languages COBOL

Second Generation Languages Prolog

Third Generation Languages C++

Fourth Generation Languages Machine Language
Fifth Generation Languages SQL
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C. Write T for True statements and F for false statements.

1. Machine language is expressed in binary form.

2. Assembly languages are not converted.

3. High-level languages are machine-dependent.

4. Interpreter programs are preferred for beginners.

5. A compiler converts the code one by one.

Juuuy

D. Answer the following questions.

1. What do you mean by machine language?




Critical Thinking

Rahul has been given a task to complete this task. Help him out to complete
the table.

Generation Popular Programming Languages

Machine Language

FORTRAN, COBOL

Third Generation Languages FORTRAN, Pascal and the C- family C++,

Fourth Generation Languages

Mercury

Team Work

Pair up with your friend and collect information about the programming
languages which you can see in the above picture. Write some lines about
each of them in the space given below.

C++ FORTRAN HTML 7S Python
ERY X === ==x X S = X === . Computer6 X Nl




ADVANCED FEATURES OF
POWERPOINT 2016

Learning Outcomes

At the end of this lesson, students will be able to:

+ Create photo album in a presentation.

+ Understand ink equations to add mathematical equations.
+ Do screen recording.

+ Add audio and video clips on a slide.

Colour the circle green if the statement is True and colour it red if the
statement is False.

Microsoft PowerPoint is a software application that allows you to create
and show slides to support a presentation.

A slide is a region surrounded by dotted borders on a slide.

WordArt is a feature that creates text effects which are not available
through font formatting.

In MS PowerPoint, shapes can not be added to the presentation.

o00®

@ Teacher’s
2 j |\ [I-H Assist students in doing the above activity and recall the features of Microsoft PowerPoint
NS

2016 learnt in Class 5.
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Hello, Friends! Let us learn
the advanced features of
PowerPoint.

PowerPoint 2016 provides various tools and features to enhance the appearance of a
presentation. A presentation is a collection of slides, arranged in a continuous manner.
Each slide can contain images, videos, tables, shapes and much more that create a greater
impact on the audience.

£, = Do You Know?

PowerPoint was first released in 1987 under the name Presenter. Microsoft had to change the name later
on due to copyright reasons.

Creating Photo Album

The different images used in a presentation make it more engaging. Various photographs
from the internet and your own personal collection are available for use. You can choose the
pictures you want from your whole collection with the help of PowerPoint’s Photo Album
tool. All of the photos in the photo album can be collected for quick access while creating a
presentation.

Follow the given steps to create a photo album for your presentation.
Steps:
1. Click on the Insert Tab.

2. In the images group, click on the photo
album drop-down menu.

3. Click on the New Photo album option.
The Photo Album dialogue box appears.

4. In the insert picture section, choose the Figure 2.1 Insert Photo From
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File/Disk tab to select pictures from your computer. The Insert New pictures dialogue
box appears.

5. Browse and navigate to the desired
location to select as many as you want, to
make your photo album.

Under the pictures in the album box, the
pictures that you select will be added.

6. Now, go to the album layout section and
select picture layout, frame shape and Figure 2.2 Insert New Picture
theme accordingly.

7. Click on create button. Your photo album
presentation is ready.

Ink Equations

You can quickly include mathematical equations
in your presentation by using the ink equation
tool.

Follow the given steps to add math equations to
your presentation.

Steps: REMEMBER IT!

1. Click on the Insert tab. After selecting all of the images, you can
arrange them in the order of your choice by
using the up and down arrows next to the
images in the Album box.

Figure 2.3 Photo Album

2. In the Symbols group, click on the
drop-down arrow of the Equation

button.

3. Click on the Ink Equation option from the list. The Math Input Control dialogue box
appears.

4. Take the cursor to the yellow grid area and click on it. Observe a small black dot appears,
from here you will start writing the equation.

5. Now using the mouse, write the equation.

6. Once done, click on the Insert button.
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Screen Recording

Screen Recording is one of the features of PowerPoint which allows recording computer
screen with audio. This recording then can be incorporated into your presentation.

i2# Let me Answer
How do you feel when you
see your childhood album?

You will require a sound card, microphone, and speakers in
order to use this feature.

Follow the given steps for adding a screen recording in
PowerPoint.

Steps:

1. Select the slide where you want to record the

screen recording.

Figure 2.4 Screen Recording Option
2. Click on the Insert tab and in the Media

group, click the screen recording option.
3. Click on the select area button.

4. Drag the mouse over the desired region of your
screen you want to record.

5. Click on the record button if you want to add audio
to the recording.

6. To end the Screen recording, place your cursor at the
top of the computer screen. A pop-up window appears
and you can click on Stop to save the recording.

7. The currently shown slide will automatically store

the recorded video. Figure 2.5 Selecting Area

Figure 2.6 Inserting Screenshot
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ADDING VIDEO CLIPS IN A SLIDE

Understanding becomes very easy when something is explained using a video. We can
also insert videos into the presentation. Video clips add liveliness to the presentation. This
featured enable the audience to engage efficiently.

Figure 2.7 Inserting video

Follow the given steps to insert a video clip onto a slide.
Steps:
1. Click on the Insert tab.

2. In the Media group, click on the video drop-down and select This PC option.

»

The “insert video dialogue box” appears. Navigate to the location and select the desired
video, then click on insert.

s

Once the video is inserted, you can change video shape, border effect, styles and much
more in the Video Format option.

o

Click on the Play button below the video clip.

MOVING VIDEOS ON A SLIDE
Follow the given steps to move videos on a slide.
Steps:
1. Select the video.

2. Move the video by dragging it to the new location.

IR X Computer6 | o X X
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OR

Press the arrow keys to move the video by small amounts.

RESIZING THE VIDEO ON A SLIDE

Follow the given steps to resize the video on the slide.
Steps:
1. Select the video.

2. Resizing handles appear around the border of the video.

3. Dragany corner in or out as per the requirement.

OR

Click on the Format tool tab. In the size group, write the specific video height or video
width and then press enter.

- = Kids’ 1Q
Farhan wants to add the following Mathematical equation in his presentation.
(©)- (- *)

NS

Suggest to him the easiest way to perform this task.

F(n)=

@ Let’s Recall

A presentation is a collection of slides, arranged in a continuous manner.

o Ink equation tool can quickly include mathematical equations in your
presentation.

o Screen Recording allows recording computer screen with audio.
o We can also insert videos into the presentation.

e Video can be moved to the new location.
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4.
5.

Upskill Your Intelligence mf

~_ 7

........................... is a collection of slides.
Ink Equation tool enables to include ........................... equations.

Using the ..., tool, you can correct any errors in the part of
the equation.

........................... enables recording computer screen with audio.

Video clipsadd .............cocooe... to the presentation.

B. Write T for True statements and F for false statements.

1

2.

4.

5.

. Videos cannot be resized in a slide.

Screen recording can be incorporated into your presentation.

Sound card, microphone and speakers are required for
screen recording.

A photo album can be created in the presentation.

Juou gy

Videos cannot be moved to a new location.

C. Answer in one word.

1.

2.

B <

The tab that is used for inserting video files in PowerPoint.

The button used to stop the recording.

The group in which the equation button is present.

The group in which screen recording is present.

— N N YN ™ M
| U G S

The tab that is used for resizing the inserted video.
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D. Answer the following questions.

1. Write the steps to create a photo album.

Ravneet made the presentation on Water Pollution. She also recorded a video
of the Yamuna River and added it to the presentation. Now, she realised the
video size is big, so she wants to reduce the size of the video and she is not able
to do it. Help her to complete this task.




B X<

Team Work

Record a video of the causes of Air pollution which you see in your daily
life. Create a presentation including those recorded videos and present it
in the class.
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MORE ON MS EXCEL 2016

@Q Learning Outcomes

At the end of this lesson, students will be able to:
+ Know about different keys.

+ Edit a cell in the worksheet.

+ Create a list using an auto-fill feature.

+ Create and copy the formulas.

A balanced diet makes us grow healthier and stronger. Children of your age
must stick to the right timetable to take proper meals. Complete the diet
table of the week given below and learn how to be healthier by eating the

healthy food.
SCHOOL EVENING
BREAKFAST LUNCH SNACK DINNER
Monday Whole whe.at bread,
eggs and milk
One chapati, green
Tuesday Vegetablg andgsalad.
Wednesday

Thursday Vegetable salad

Friday
Saturday Boiled vegetable rice
Sunday

)
‘i Teacﬁe: i From the above activity, introduce to the students that there might be chances when we
\f Sl ont to replace some meals with others. This needs modification, so it can be done easily
in MS Excel worksheet.
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Hello, Friends! In the previous
class, we learnt the features of
MS Excel 2016 and performed
calculations. In this lesson, we
will learn about various ways to
edit the data in the worksheet.

Let us learn the function of a few keys that are used for modifying the data in a worksheet.

FUNCTIONS OF KEYS
Arrow Keys

To move one cell up, down, left, or right, use the arrow keys. The next cell in the worksheet
can be selected using the Shift + Arrow key combination.

Backspace

You can remove the content of the active cell by pressing the backspace key. We can remove
one character to the left of the insertion location by turning on the editing mode.

Delete

This key removes the contents of the cell including the formula applied to the selected cells.
Deleting the content does not affect the cell formats or comments. In cell editing mode, it
deletes the character to the right of the insertion point.

End
This key can be utilised in different ways.
<> This key will move the insertion point to the right of the cell content if edit mode is on.

< To activate the last used cell in the lower right corner of the active worksheet, press Ctrl
+ End.

Enter

After entering all of the text into the active cell, we can press the Enter key. As we press enter
key, the next cell would be activated in the worksheet.

B X Computert | e X X vl
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Home

The first visible row in the worksheet will be activated when we press the Home key.

Page Down

To move one screen down, we can press the Page Down key.
Page Up

To move one screen up, we can press the Page Up key.

Spacebar

This key can be utilised in different ways.

< To select an entire column in a worksheet, press Ctrl + Spacebar.

< To select an entire row in a worksheet, press Shift + Spacebar.

< To select the entire worksheet, press Ctrl + Shift + Spacebar.

Tab

To move to the right cell of the active cell, we can press the Tab Key.

Entering Text

Follow the given steps to enter the data in the cell.
Steps:

1. Click on the desired cell.

2. Type the text in the cell.

3. Press the Enter Key.
Editing Cells

We might enter the wrong text or value in the cell. MS Excel allows to quickly and easily

change the cell value.

Follow the given steps to edit a cell in the worksheet.
Steps:
1. Click on the cell you want to edit.

?

2. Double click in the cell or press the F2 Key.
3. Erase the cell data.
4
5

Press the Enter Key.

B X X
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B
<2 % Do You Know?

You can edit the cell by clicking the desired
Type the new data. cell and making changes directly in the
Formula bar.

Computer-6 = S



Figure 3.1 Editing Cells

Figure 3.2 Editing Cells with Formula Bar

Using Edit Mode

To update the content of the active cell, we can use The Edit mode.

Follow the given steps to edit the content of a cell.

Steps:

1. Double-click on the cell you want to edit.

2. Observe the cursor blinking, which
signifies that the cell is ready for I
editing REMEMBER IT!

3. Change the text and press the Enter Press. Alt + En.ter key combination to enter
key multiple data in the same cell.

X Computer6 | mmmm m X aEmK X X == = ¥ === X




Figure 3.3 Ready Mode

Figure 3.4 Edit Mode.

AutoFill

AutoFill feature automatically fills a series of data in your worksheet. For example, we may
use the list of months and days in our worksheet frequently. To make it easy to enter repetitive
or sequential lists of information, there is a special feature in Excel called AutoFill.

Qj}@
§2¥ Let me Answer

feature. What do youmean by automatic?
Give an example of a thing which
works automatically.

Follow the given steps to create a list using an auto-fill

Steps:

1. Enter the first two values you want to start the series
with.

2. Select both the cells in which you have entered the data.

3. Position the mouse pointer over the bottom right corner of the last selected cell. Observe
the pointer changes to the (+) sign.

IE(pees X X === . Computer6 X M
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4. Drag the mouse to where you want the series.

Figure 3.5 Enter Desired Values

1
Ni

5. Observe the cells filled with the desired values.
Figure 3.6 Auto Fill
Delete Option
Deleting Cells
Follow the given steps to delete the cells.
Steps:
1. Select the range of cells to be deleted.
2. In the cells group, on the home tab, click on the drop-down arrow of the delete option.
3. The delete dialogue box will appear, click on the delete cells.
4. Now, choose the desired option.
5. 'The selected cells will be deleted.
Figure 3.7 Delete Cells
X Computert | e X X )R X X ==




Deleting Rows/columns

Follow the given steps to delete the rows.

Steps:

1.
2.
3.

4.

Select the row to be deleted.
In the cells group, on the home tab, click on the drop-down arrow of the delete option.

Select the Delete sheet rows option.

The entire row will be deleted.

Creating Formulas

Formulas make the task of performing calculations easy. It lets us perform simple as well as
complex calculations. In MS Excel, almost all types of formulas can be applied for performing
calculations.

Follow the given steps to perform calculations using simple formulas.

Steps:

1. Enter the two numerical values in cells C1 and C2.
2. Click in cell C3 where you want to add the formula.
3. Incell C3, type =average(C1:C2)

4. Press the Enter key.

Observe that the average of the values entered in cells C1 and C2 is displayed in cell C3.

Figure 3.8 Average Formula

Figure 3.9 Formula
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Copying a Formula

There are two methods to copy a formula.

i,
$2# Let me Answer

1. Using the Fill Handle Is there any difference between
the formulas you apply in maths
Steps: and on the Excel worksheet?

1. Click in the cell that contains the formula.
2. Position the mouse pointer over the lower-right corner of the cell until it turns (+).

3. Drag the fill handle over the cells to which you want to copy the formula, then
release the mouse button.

2. Using Copy and Paste
Steps:
1. Select the cell that contains the formula, and on the Home tab, click Copy.
2. Select the cell or cells where you would like to paste the formula.

3. On the Home tab, click Paste.

s Kids’ 1IQ

Have you ever thought about why we use formulas?

---------------------------------------------------------------------------------------------------------------------------------------------

Let’s Recall

1. To move one cell up, down, left, or right, use the arrow keys.
MS Excel allows to quickly and easily change the cell value.

AutoFill feature automatically fills a series of data in your worksheet.

2
3
4. You can remove the content of the active cell by pressing the backspace key.
5. There are two alternative methods for copying formulas in Excel.

6

In Excel, a formula starts with = sign.
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. Fill in the blanks.

Lo key can remove the content of the active cell.

2. Deleting the content does not affect the cell ................... or comments.
3. feature automatically fills a series of data in your worksheet.
4. In Excel, a formula starts with the ....................... sign.

5. To move one cell up, down, left or right, use the ....................... keys.

. Write T for True statements and F for false statements.

1. In MS Excel, almost all types of formulas can be applied for performing
calculations.

Using the fill handle option, we can paste a formula.
Copy option is available on the File tab.
Press the F2 key to edit the cell.

Formulas do not let us do complex calculations.

o B

seuae

. Answer in one word.

1. Bypressingthiskey, the first visible rowin the worksheet will be activated.
2. 'This key is pressed to move one screen down.
3. Keys combination pressed to select an entire column in a worksheet.

4.  This key is pressed to move to the right cell of the active cell.

5. The mode which is used to update the content of the active cell.

. Answer the following questions.

1.  State one difference between Page Up and Page Down key.




2. What do you mean by the Autofill feature?
3. Write the function of the End key:.
4. Write the steps to edit the content of a cell
5. How can we copy a formula?
[, #\ Critical Thinking

:

Sam wants to create a timetable for self-study. He does not want to type the

names of all the days on the worksheet. Suggest him the tool he should use to

add the days automatically.
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Team Work

Prepareamarksheet for 20 students for the subjects- English, Mathematics,
Science, Hindi and Social Studies. Follow the given instructions.

o Insert a column of Average to the right of the total column.
o Insert a row below the fifth row.
« Using AutoFill features, fill the roll numbers 1 to 20 for the students.

o Find the average using the formula.
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FORMULAS AND
FUNCTIONS IN EXCEL

Learning Outcomes

At the end of this lesson, students will be able to:
+ Comprehend the significance of formulas and functions.

+ Differentiate between formulas and functions.

Observe the following marks of the students. Fill in the missing numbers.

Roll No. Name English Maths Science Total
1 Anushka 60 52 56
2 Kanchan 65 58 179
3 Surovhi 76 76 241
4 Niharika 68 75 208
5 Shruti 88 89 82
6 Megha 89 68 238
7 Rahul 100 99 72
8 Shubham 87 100 250
9 Utsav 62 53 75
10 Madhvi 62 78 84
X Tﬁcﬂg:;s: Inform students that the above task can be done quickly and effectively in MS Excel as
2\ it holds a wide range of formulas and functions that are easy to use.
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Hello, Friends! As we know,
Excel is one of the most useful
programs and can provide us
with a wide range of tools to
work. Let us learn how to use
formulas in Excel.

Formulas are the user-defined instructions to perform calculations, whereas functions are
the pre-defined or in-built formulas that come with excel.

WORKING WITH FORMULAS
A formula establishes a relationship between two or more cells. All Excel formulas have

same general structure: an equal sign (=) in the beginning. Using the formulas, you can
perform simple as well as complex calculations.

The elements included in the Formulas are:

o References: Range of cells included in the calculations.
o Operators: Symbols that mention the operation to be performed.

o Constants: Numbers or text values that do not change.

5 N

o Functions: Pre-configured formulas in Excel. <2 % Do You Know?

A range is a rectangular area made up
of a collection of cells that are close to
one another.

# T X _‘ Computer-6 = A
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REMEMBER IT!

Formulas are not case sensitive. E.g. = b5 +
c5 is similar to =B5 + C5

ELEMENTS OF FORMULAS IN EXCEL
( Cell Address )

— +
— * _ . O
> =C3+ D3T 4 “AvTerage*(E3 : E5)
( Equal to Symbol ) ( Function )

(Mathematical Operators )

Input Modes

Three input modes in Excel control how specific keystrokes and mouse clicks are interpreted.
These input modes are as follows:

Enter Mode: This mode appears when you type the equal sign to begin the formula. It
is the mode you use to enter text.

Point Mode: Excel enters Point mode when we press any navigation key on the
keyboard. This is the mode you use to select a cell or range as a formula operand.

Edit Mode: Excel enters Edit mode when we press the F2 key.
This is the mode you use to make changes to the formula.

59 Let me Answer
What do you mean by Input?

Rules for Entering formulas in cell.

1.

o

»

i

"

Click the cell in which you want to enter the formula.
Type = sign to specify that youre entering a formula.

Type the Operands and operators of Formula.

Press Enter to get the desired result.
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FORMULAS IN EXCEL
Arithmetic formulas
Arithmetic formulas are by far the most common type of formula. They conduct calculations

by combining numbers, cell addresses, and the result of functions with mathematical
operators.

Operator Name Example Result

Figure 4.1 Arithmetic Operators
Comparison Formula

An expression that compares two or more numbers, text strings, cell contents, or function
outputs is known as a comparison formula. The result of the formula gives the logical value
true if the comparison statement evaluates to be true. If the comparison statement evaluates
to be false, the formula returns the logical value false.

Operator Example Result

Figure 4.2 Comparison Operators
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Reference Formulas

The following table mentions the operators you can use in reference formulas.

Operator Description

Figure 4.3 Reference Formulas
Cell Reference &

A cell reference is a cell address that can be used in a
formula to denote a specific cell. We can refer to a cell with

s; Let me Answer

_ What is the meaning of reference?
its address. How can you relate it with Reference
Formulas?

There are three types of cell references:

Relative Reference

When a formula is copied from one cell to another cell, the value in the copied cell
automatically gets changed.

Follow the given steps to use the relative cell reference.
Steps:

1. Select the cell that contains the
formula in which the reference of
other cells is used. In this case, we
have selected cell C12, in which
the formula =Sum(C3:C11) is
written.

N

Click on the copy command
from the clipboard group under
the Home tab.

»

Select another cell, here we
have selected cell D12. Click on
the Paste command from the

clipboard group under the Home
tab. Figure 4.4 Relative Reference
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4. Observe in the Formula bar that the cell address that you have used in the formula gets
changed according. Here, D12 has the cell reference from D3 to D11 instead of C3 to
C11.

Absolute Reference

Use an absolute reference if you want to keep the original references exactly as they were.
The column reference and the row reference should be preceded by a dollar symbol if you
want the formula to keep its original reference when it is copied.

Let us see.
Steps:

1. Selectthe cell C12, change the formula
in the address bar to =SUM($C3:
$C11).

2. Select the cell C12 and click on the
copy button in the clipboard group.

3. Select cell D12 and select the Paste
button from the clipboard group.

See the values in the address bar, see the

cell reference is still C3 ro C11. Figure 4.5 Absolute Reference

Mixed Reference

A mixed reference is a combination of relative and absolute references. Either a row or
column has to be locked preceding it with a Dollar symbol.

Steps:
1. Add a column In-stock with some values as shown.

2. Click on cell C13 and types
this formula =$C12 - E$12.

3. Copy and Paste this formula
in the cell E13.

See the address bar the formula

is =$C12-G$12. The reference to

C12 remains the same but, E12
has changed, Figure 4.6 Mixed Reference
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References to other worksheets

You can refer to cells in other worksheets within the same workbook.

Using Copy - Paste Option

Follow the given steps to use Copy-paste option.

Steps:

1. Click on the Sheet 1 tab.

2. Click on the cell C12 where the SUM function is used.
3. Using Ctrl + C, copy the formula.

4. Click on the sheet 3 tab and click on the cell C11.

5. Press Ctrl + V to paste the formula.

Figure 4.7 Using Copy-Paste Option (1 & 2)

Using Sheet reference

In this, we use sheet number, exclamation mark and cell address to refer to a cell of a particular
worksheet. For example, Sheet1!D6; means we're referring to the cell D6 of Sheetl.

1
Ni

Steps:

1. Add Sheet4 to the Workbook and types the values in Sheet4.

2. In Sheet4, cell B11 type the formula =1000 +Sheet1!C11.

3. Press Enter and observe the changes in the value shown in the cell B11.
B X Computert | e X X K X X ==




Figure 4.8 Using Sheet Reference

Functions

Functions are predefined formulas in Excel to perform simple and complex calculations.
Functions eliminate the chance to write incorrect formulas. They accept the arguments and
return values. Arguments are the information which contains input values to the function.
The values are given within ( ) parenthesis. Arguments can be numbers or text, etc. Return
values display Function output.

Rules to Enter a Function

o All Excel functions must begin with = sign.

o The function name must be a valid Excel name.

e Open and close parenthesis must be placed after the function.

o Arguments must be enclosed in Parenthesis.

Average Function

The Average function returns the average of the range values. The arguments can be a range
of cells, simply numbers or numbers along with cell reference(s).

Follow the given steps to calculate the average.

Steps:
1. Click on the cell where you want to place the average of values. Let us say C11 sheet 1.

2. Select the Insert Function button on the Formulas tab to open the Insert function
dialogue box.

3. Select Average from the list box and click on the Ok button.

B X X
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"

Drag the mouse pointer to cell D6.
The cell E6 will display =AVERAGE(C6:06).
Type the closing parenthesis symbol and press the Enter key.

NS e

The cell E6 will display the calculated result.

Figure 4.9 Insert Function Figure 4.10 Function Arguments

- s Kids’ 1Q

Kanchan has made a spreadsheet for the marks obtained by the students of her class
in different subjects. Which option should she select to update the spreadsheet if
she has to change marks in one of the subjects of any student?

@ Let’s Recall

An Excel formula starts with an = sign.

Formulas are the user-defined instructions to perform calculations.
Functions are the pre-defined or in-built formulas that come with excel.
Excel gives you three ways to enter the Edit mode.

The Average function returns the average of the range values.

Mixed reference is a combination of Relative and Absolute reference.

NS o WD

Absolute reference is used to keep the original references exactly as they were.
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A. Fill in the blanks

1. A formula establishesa ................... between two or more cells.

2. Thereare................. input modes in Excel.

3. formulas are the most common type of formula.

4. A cell reference is a cell ................... that can be used in a formula to
denote a specific cell.

5. A mixed reference is a combination of .................. and ...................
references.

B. Write T for True statements and F for false statements.

1.

Enter mode begins when we press any navigation key on
the keyboard.

Absolute reference is used to keep the original reference exactly
as they were.

Functions eliminate the chance to write incorrect formulas. D
We can refer to a cell with its address. D

Arguments must be enclosed in Parenthesis.

C. Define the following.

1.

2
3
4.
5

FUNCtiONS e
References
OPperators
COoNStants e

Comparison Formula .
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D. Answer the following questions.

1. Explain the types of input modes.

'\ #\ Critical Thinking

E ]

ABC International school organised a cricket match between class 6th A and
6th B. Saumya, one of the students, was asked to prepare a worksheet to save
the runs scored by each player. Now, she has prepared it and wants to copy the
data along with the formula and paste it into another worksheet. Suggest her
the cell reference she should use to perform the task.




Team Work

A. Create a worksheet in which you would maintain your Monthly Expenses
on Stationery. The worksheet must have the following headings: S.No.,
Commodity, Price, Quantity. Find the total for each heading by using
formulas learnt in this chapter.

MONTHLY EXPENSES

S. No. Commodity Price Quantity Remarks

B. Conduct a group discussion on the topic: Function vs Formula

B X X
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COMPUTATIONAL
THINKING

Learning Outcomes

At the end of this lesson, students will be able to:
+ Comprehend computational thinking and its importance.

+ Know the components of computational thinking.

You are Mario, tick marks the things you will think of while playing this
game.

<> What items do you need to collect?
<> Determine the exit and the fastest way to reach the finish line.

< Different types of enemies and ways to destroy them.

‘W% Teacl!l‘e[’s' Inform students that you always analyse the situation, and think of actions to work out
Q. f ote: strategy for completing the level in the most efficient way. This is a problem-solving
procedure.
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Hey! Friends. Do you know
that computational thinking
is an interrelated set of skills
and practices for solving
complex problems? Let us
learn about it.

WHAT IS COMPUTATIONAL THINKING?

Computational thinking is the step that comes before programming. It’s the process

of breaking down a problem into simple enough steps. This can be connected to high-

order thinking skills and is not bound only to computers. Itisa (@,
. . . : 2 Let me Answer

method of problem-solving that aids the user in comprehending, S

) ; .5 In what situation do we apply

interpreting and resolving issues. high-order thinking skills?

Computational Thinking Involves:

< Logically segmenting a problem into smaller segments.
< Application of general concepts to broken problems.

< Searching for recurring patterns in the problem.

<> Determining relevant details and omitting the unnecessary ones.

<* FPollow an algorithm to make decisions and produce the right answer.

KEY SKILLS OF COMPUTATIONAL THINKING
There are four key skills in computational thinking:
<> Decomposition
<> Pattern Recognition
<> Pattern Abstraction

< Algorithm Design
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Decomposition

Decomposition is the method of breaking complicated
issues into smaller, more manageable pieces. When a
problem is considered in its whole, many problems
appear to merge, which causes confusion. But when a
problem is broken down into parts, it makes getting at
the solution easier step-by-step away. Any work that
is completed sequentially is easier to complete and
facilitates understanding of the steps.

REMEMBER IT! &8

Pattern recognition is the special ability
of the human brain to not only find the
patterns but figure art in a logical way.

Figure 5.1 Computational Thinking

Pattern Recognition

A pattern is a repeated design. Our brain

recognises a variety of patterns in daily life. Figure 5.2 Decomposition
The process of pattern identification is crucial in

computational thinking since it allows the user to find solutions more quickly. Once a
problem is broken down, discovering patterns in the broken parts simplifies work.

Pattern Abstraction k2% Let me Answer

. . . H heard th
A problem can be made easier to think about by abstraction. Ws:;y ;;;;Zoégn in i ome

This entails concealing irrelevant data and displaying just |other subject?
relevant information. It is one step that helps us to arrive at a
logical conclusion.

Algorithm design 4 Dress yourself up. )
Put some money in your wallet.
Go to the shop.
Ask for your favourite chocolate.
If your desired chocolate is available,
go to step 6 else go to step 9.
Ask for any other chocolate.
Go to step 7.
Give money to the shopkeeper.
Keep the chocolate with you.
\_ Go back home. J

Algorithm design is setting out the steps
and rules needed to follow in order to
achieve the desired outcome.
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IMPORTANCE OF COMPUTATIONAL THINKING

<* Develops reasoning and logical thinking.
< Aids in understanding patterns and sequences.

<> Onceestablished, an algorithm can also be employed
in the future, saving time.

?

<> By using computational thinking, one not only

identifies issues but also offers a solution. .
concepts and resoning.

Computational thinking
mental skill to apply fundamental

==
&% Do You Know?

is

the

FLOWCHART IN COMPUTATIONAL THINKING

The quickest and cleanest way to solve any problem is to define the issue and work your way

through a flowchart step by step.

Let us work through a flowchart on how to make a cup of coffee.

C Fillkettle )
. Heat water .

l No

s the water boiling

Yes

.>our water in a cup.

..lt coffee pouch and mi.
(Cstop )
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What is one of the key skills of computational thinking which start with letter D
and ends at letter N?

ooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

Let’s Recall

1. Computational thinking is a problem-solving process.

2. Computational thinking is the process of breaking down a problem into simple
enough steps.

3. A problem can be made easier to think about by abstraction.

4. Decomposition is the method of breaking complicated issues into smaller, more
manageable pieces.

5. A pattern is a repeated design.

Upskill Your Intelligence \v/%

A. Fillin the blanks.
1. Computational thinking is the step that comes before .....................

2. A is a repeated design.

3. The process of breaking up a problem into manageable and
understandable portions is known as .................. :

4.  Computational thinking aids in understanding ... and

B = Computer-6
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B. Write T for True statements and F for false statements.

1. An algorithm once established can be used at later times. (]
2. Pattern reference is one of the key skills of computational thinking. [ |

3.  When a problem is broken down into parts, it makes getting at
the solution easily. D

4. Our brain is not capable of recognising a variety of patterns. (]

5. Computational thinking not only identifies issues but also
offers a solution. ()

C. Answer in one word.

1. The method of breaking complicated issues into smaller, more
manageable pieces. ( ]

2. The process of identifying a pattern. ( )

3. This key element of computational thinking hides the irrelevant data
and display just relevant information. ( ]

4. Setting out the steps and rules needed to follow in order to achieve the
desired outcome. ( ]

5. 'The quickest and the cleanest way to solve any problem. | ]

D. Answer the following questions.

1. What is computational thinking?

2. What is the importance of computational thinking?




3. Name the key skills of computational thinking. Explain any two.

4.  Define the algorithm with an example.

5. What is pattern recognition?

.
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Team Work

Work with your partner. You and your cousins are planning to meet
after a long time. You all are looking for probable options. Complete the
flowchart using the instructions given to come to a result.

Cousins Meetup

Meetup Point

The place where you would go.

Who wants to do what?

I
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INTRODUCING PYTHON

@“ Learning Outcomes

At the end of this lesson, students will be able to:
+ Know the python language and its features.
+ Learn the components of python window.

+ Start python IDLE and interactive mode.

Tara and Mahi are locked inside the room. Their friend has come to unlock
the door but the lock requires a password. Help her out in decoding the

password.

Inform students that the set of instructions is ‘input’, executing the instructions leads to

j (I processing’ and the answer after decoding the password is ‘output’. Likewise, a computer also

2\ works in three stages. To get the work done on a computer, you enter the raw data (input),
a computer operates on this data (processing) and the desired result is obtained (output).

9% Teacher’s
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Hey! Friends. Computers could understand
a language made up of Os and 1s known as
machine language or low-level language.
Humans found it challenging to write or
understand instructions using Os and 1s,
so it led to the invention of a high-level
programming language - Python. Let’s learn
more about it.

WHAT IS PYTHON?

A programme is an organised series of instructions that a computer must follow in order
to do a certain task, and the language used to specify this programme to the computer is
referred to as a programming language.

Python is one of the most popular programming languages widely used throughout the
world to create apps for automation, using Al, building applications for websites server-side
coding, machine learning algorithms and more.

29 Let me Answer
FEATURES OF PYTHON What is the full form of AI?

<* Python is an open-source programming language, which
implies that anyone who is versed with Python is capable of creating new programmes
and adding them to the available python libraries.

< Python is freely available on the internet and can be easily downloaded from www.

python.org.

<* Python is portable and platform independent means it can run on various operating
systems and hardware platforms.

<* Python has a rich library of predefined functions. sy
You can use these library modules to add impressive WE=R [/ (i1TH (1T1)"ks
functionality to your programs.

Python is also a kind of snake which
< Pvthon’ is cl i d simpl is non-venomous and found in Asia
v ythons syntax 1s clear, concise and simple to s

comprehend. Africa and Australia.
EX X =X =XX # X X ==== _ Computer-6 = =




Python Interface

Python provides two different modes for writing programs. There are two ways to use the
Python interpreter:

a. Interactive Mode REMEMBER IT! &

b. Script Mode

Individual statements can be instantly | after the British TV show Monty Python’s
carried out in interactive mode. | Flying circus.

Python is not named after the snake, but

Whereas, Script mode allows us to write
more than one instruction in a file called Python source code file that can be executed.

Installing Python

As we already know that Python can be freely downloaded from the web. It can be installed
from the Python website, https://www.python.org/.

Follow the given steps to install Python on your computer.

Steps:

1.

D

"

Open www.python.org to download the latest version of Python.

Figure 6.1 Installing Python
Click on the Downloads buttons and click on the button shown in the following picture.

Figure 6.2 Python Download
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3. Click on Install now in “The python Setup’ window to install Python.

Figure 6.3 Install Python

4. The installation progress will be shown in the progress bar window.

Figure 6.4 Python Installation Progress Window

5. 'The installation status will be shown on the last screen. Python will show the following
screen after the installation process has been successfully completed.

Figure 6.5 Completing Python Setup
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COMPONENTS OF PYTHON WINDOW
Let us learn about the various components of Python Shell.
Title Bar: The name of the application and the document are displayed here.
Command buttons like Minimise, Maximise, Restore and Close are presented here.

Menu Bar: Various tabs such as File, Edit, Shell, Debug, Windows and Help are displayed
here.

Script Area: The area where you type the code.

Status Bar: Current status of your cursor is displayed here.

STARTING PYTHON IDLE
Follow the given steps to open the Python interface.

Steps:

1. Click on the Start button.

2. Click on All apps and scroll down to the Python folder and select the IDLE option.
3. 'The Python IDLE screen will open.

Figure 6.6 Python IDLE
Python IDLE and Interactive Mode

Every Windows application has a unique user interface that makes it easier for users to use
it to its fullest potential. We can perform different tasks like saving, opening, debugging,
configuring IDLE settings etc.

Interactive Mode

In Python Interactive mode, the python IDLE screen looks as shown below.
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Figure 6.7 Interactive Mode
Python Command in the Interactive Mode

1. Open the Python IDLE.

2. You can see a welcome message from the Python interpreter with version details and
“>>>’ the python prompt. It is a primary prompt that specifies that the interpreter is
expecting a command.

3. Type the following statement and press the Enter key.

Figure 6.8 Picture
4. Observe that “Welcome to Python Programming’ and ‘Hello’ is printed on the screen.

PYTHON IDLE AND SCRIPT MODE
Script Mode

Follow the given steps to use the script mode.

# T X _‘ Computer-6 = A
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Steps:
1. Start Python IDLE.
2. Click New on the File menu.
3. Type the commands in the window that opens.
Figure 6.9 Screenshots 2 & 3
4.  Click on save on the File menu.
5. Name the file with the .py extension.
Figure 6.10 Screenshots 4 & 5
N = >
.. Kids’ 1Q
To save a python file, which extension do we use?
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’ Let’s Recall

. Python is one of the most popular programming languages.
2. Python has a rich library of predefined functions.

3. Python provides two different modes for writing Python programs: Interactive
mode and Script mode.

4. Individual statements can be instantly carried out in interactive mode.

5. Primary prompt specifies that the interpreter is expecting a command.

. Upskill Your Intelligence =

A. Fill in the blanks

1. Pythonisan ........... programming language.

2. Python is freely available on the ................... :

3. Python provides .................... different modes for writing programs.
S statements can be instantly carried out in interactive mode.
5. The name of the application and the document are displayed on the

B. Write T for True statements and F for false statements.

1. Python has a rich library of predefined functions.
2. Python is platform-independent.

3. The Python prompt specifies that the interpreter is expecting
a command.

4. 'The area where you type the code is the Status bar.

5.  You can perform mathematical operations using Python
Interactive mode.

, 0 00 00
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C. Arrange the following steps in the correct order to install Python.

1. The installation status will be shown on the last screen. Python

will show the following screen after the installation process has

been successfully completed. (]
2. Click on Install now in “The python Setup’ window to install Python.[ |
3. Open www.python.org to download the latest version of Python. [ |
4.  Click on the Downloads buttons and click on the button shown

in the following picture. D
5. 'The installation progress will be shown in the progress bar window.[ |

Answer the following questions.

1. Whatis Python?

) Dlscuss thefeaturesof Pﬁhon .....................................................................

3. Exp]am the ' Components Of the PYthon W mdo W ........................................

) ertethestepstouse thescnp tmodempwhon ......................................

5. Witethe difference between an intractive mode and.a sript mode.
Compmer6 .......... =::xx2i??ix-




/. #\ Critical Thinking
Y
Unscramble the words to make the components of the Python window.

1. RTISCPRAAE - ... 2. LIETTRAB - ...,

3. TTSSUARAB- ..o, 4. UENM RAB - ...

With the help of the Internet, name any four programming languages and
their developers.

Programming Language Developer name
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INTRODUCING HTML

Learning Outcomes

At the end of this lesson, students will be able to:
+ Know about HTML and its features.

+ Rules for writing HTML codes.

+ Contrast between a container and empty tags.

+ Design a Web page.

Samaira wants to surf some of the famous websites. Provide her with the
website links of the following.

@ Teacher’s
2\ j LUCHR Ak students if they have ever thought about which language is used to build these superb

websites. Inform them that Markup languages are used to create websites.
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Hello Friends!! We use Markup

languages to create websites. HTML
and XML are the most popular
Markup Languages.

Lets learn about one of them, i.e.
HTML

INTRODUCTION TO HTML

HTML stands for Hypertext Markup Language. It is one of the most popular and widely
used languages for creating web pages. Websites consist of multiple web pages with text,
pictures, videos, and animation because of HTML. HTML contains a number of tags that
are easy to learn and work with.

Tim Berners-Lee developed HTML in 1991.

HTML Released Year

@ Let me Answer
What is the full form of HTML?

Key Features of HTML

< A platform-independent language.
< A very easy and simple language.

< Tt allows us to build tables and add a link to the web page.

M
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< Tt offers a flexible way to construct web pages along with the text.

Let me Answer

TERMINOLOGIES RELATED TO HTML Explain Platform independent
language.

Hypertext

Using tags called Hypertext, a basic text is transformed into a dynamic text. Also, it has the
unique ability to link to other web pages.

Markup Language

A language which uses special symbols called Tags to format text documents and tells the
browser how to display the text.

Tags

Tags are the basic building blocks of a web page. Each N

: - # Do You Know?
HTML tag carries out a certain task, and some are used for
formatting text while some are used for adding images and | HTML is also called tag-
videos and some others are used for navigation. based language.

@

Webpage

A webpage is a formatted document that is translated and displayed by the web browser of
your computer system.

Rules for Writing HTML codes

In order to write HTML codes, we need to abide by some rules. These are:
< Tags should always be surrounded by angle brackets. < >

< Values given to the attributes should be

enclosed within the double quotes. REMEMBER IT!

There should be no spaces between
<and > in a tag.

Tags in HTML

HTML is a markup language which uses tags to

markup the content of web pages. Tags are used as keywords in HTML. Each tag is used
to carry out a certain operation, which browser software can recognise. Attributes are
characteristics that have been assigned to each tag. Attributes of tags can be used to modify
their properties.

Let us look into some HTML tags and their attributes.
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Tag Attributes
<BODY> Background
<Font> Face, size, colour
<IMG> SRC, width, height

The HTML tags can be categorised as

< Container Tags: A tag that has both an open and close tag is called a Container tag. For
Example: <HTML> ... </HTML>

Opening Tag Closing Tag

<> Empty Tags: A tag that only contains an open tag and no closing tag is called an Empty
Tag. For Example: <BR>, <HR> and many more.

< Block Level Tags: The block level tags start on a new line by default and occupy the
entire available width. For Example: Paragraph <P>, Horizontal rule <HR>, etc.

<* Text Level Tags: The text level tags are used to mark up parts of the text. These tags do
not start with a new line. For Example: Bold <B>, Subscript <sub>, etc.

Structure of HTML document

The HTML file is a text document that contains markup tags. The markup tags instruct
the web browser on how to display the webpage. An HTML file is saved with .htm or.html
extension.

Let us learn the basic structure of the HTML document:
<HTML>

<HEAD>

<TITLE> Title of the web page </TITLE>

</HEAD> REMEMBER IT!

Head contains the information
which is not to be shown on the
web page whereas body contains
</BODY> the information which is to be
shown on the web page.

<BODY>

Content of the web page

</HTML>
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Designing a Web Page

We already know, how to create a basic HTML document. Now, let us learn to create a web
page using some different tags.
<html>
<head>
<title> English Essays </title>
</head>
<body bgcolor="green”>
<h1> English Essays </h1>
<h2> 1. Importance of trees </h2>

Trees give us life directly and indirectly as they are the source of oxygen production, CO,,
consumption and source of rain. They are the most precious gift to humanity on the earth.
We must be grateful, give honour and preserve it for the wellness of humankind. We should
understand the importance of trees in our lives and do our best to save trees to save a life,
save the environment on the earth and make the earth a green earth.

</body>
</html>
Type the above in the Notepad window with the desired name.html

This file can be located in Windows Explorer, and double-click on the file icon.

The web page will appear like this:

Figure 7.1 Web page

EDITING AN HTML DOCUMENT
Follow the given steps to edit an existing HTML document.
Steps:
1. Navigate to the location where you've saved your file.
2. Right-click on your file to open the context menu.
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3. Move your cursor over the ‘Open with * option, and a sub-menu will open.

4. Click on the Notepad.

Figure 7.2 Editing HTML File

Once you are done making the changes, you need to save the file by pressing the Ctrl + S
keys.

< Kids’ 1Q

Where do we write the HTML document?

! Let’s Recall

HTML stands for Hypertext Markup Language.

o Tags are the basic building blocks of a web page.
o Attributes are characteristics that have been assigned to each tag.
o A tag that has both an open and close tag is called a Container tag.

o A tag that only contains an open tag and no closing tag, is called an Empty
Tag.

o 'The markup tags instruct the web browser on how to display the webpage.

o An HTML file is saved with .htm or.html extension.
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w% Upskill Your Intelligence

~
Fill in the blanks
1. HTML stands for ..., .
2, developed HTML in 1993.
3. HTMLisaplatform ................... language.
4o are the basic building blocks of a web page.
5. e are characteristics that have been assigned to each tag.
Write T for True statements and F for false statements.

1.

2.

HTML was developed in 1981.
HTML is a very difficult language.
Hypertext transforms a basic text into a dynamic text.

Tags should always be surrounded by curly brackets.

A tag that only contains an open tag and no closing tag
is called a container tag.

U gougdgy

Answer in one word.

Computer-6 | S o X ()

The basic building blocks of a web page. ( ]

A language which uses tags to format text documents and tells the
browser how to display the text. ( ]

A formatted document that is translated and displayed by the web
browser.
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D.

4. Characteristics of tags that can be used to modify them. | ]

5. 'The tag starts on a new line by default and occupies the entire available
width. ( ]

Answer the following questions.

1. What is the basic structure of the HTML document?

---------------------------------------------------------------------------------------------------------------------------
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Critical Thinking

Solve the crossword using the given clues.

Down:

1. The tags which have only an opening tag.

2. Most commonly used Text Editor for web page designing.

3. A tag that transforms a basic text into a dynamic text.

5. Attribute used to change colour of the text in a web page.

Across:

3. Markup language used to create web pages.

4. Tag used to define the text to be shown on the web page.

6. Tagis used to define what is to be shown on the title bar when the web page

is opened in the web browser.

7. Tagused to define header area of the web page.
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Team Work

A. Surftheinternet with the help of your teacher to find out the programming
languages used for creating these websites.

www.youtube.com - www.google.com -

www.facebook.com - www.twitter.com -

B. Find out 10 website and programming language used to create it by using
Google.

Name of the website Programming language used to
create the website

Remarks :- What you have learned from this exercise?




INTRODUCING ARTIFICIAL
INTELLIGENCE

@“ Learning Outcomes

At the end of this lesson, students will be able to:
+ Know about Al and its types.

+ Learn about the history of AL

+ Understand the components and benefits of Al

+ Recognise various applications of Al.

You want to reach the new location. Your father has verbally explained the
way, but you got confused. Which application programme would you use to
locate the new location?

A boy and a road ahead

‘¥ Teacher’s . o , , A
j \\[1:HR Guide the students about the application and introduce to them with the word Artificial
2\ Intelligence.’
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Hello Friends!! As we know, the ability
to derive information, learn from
experience, adapt to the environment,
understand, and correctly utilise
thought and reason is defined as
intelligence. In this chapter, let us
learn what Artificial Intelligence is.

The ability of computers to do a wide range of jobs has exponentially expanded since their
introduction. Humans are responsible for developing computer systems in terms of speed
and reduced size. With the progress in technology now, we have self-driving cars, face and
voice recognition apps, flying drones, voice assistant apps and much more. These applications
use various technological tools to learn and make decisions independently. This ability of
applications or machines is known as Artificial Intelligence.

ARTIFICIAL INTELLIGENCE

The intelligence demonstrated by a machine is known as Al This intelligence is almost
identical to humans. It is a way of making the computer, a computer-controlled robot or
software which thinks intelligently, as intelligent humans think.

Artificial intelligence (A.IL) is generally defined as the property of machines that mimic
human intelligence, characterised by cognitive ability, memory, learning, and decision
making.

62 Let me Answer
Tell about the devices which
use Artificial Intelligence.

The ideal characteristic of artificial intelligence is its
ability to rationalise and take actions that have the best
chance of achieving a specific goal. A subset of artificial
intelligence is machine learning (ML), which refers to the concept that computer programs
can automatically learn from and adapt to new data without being assisted by humans.
Deep learning techniques enable this automatic learning by absorbing huge amounts of
unstructured data such as text, images or video.
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All is a technique that enables
computers and machines to mimic
» human intelligence, using logic,

Machine
Learning

if-then rules, decision trees, and
machine learning

A subset of Al that includes abstruse
statistical techniques that enables
machines to improve at tasks with
experience.

The subset of machine learning
composed of algorithm that

Deep —>  permits software to train itself to

Learning

Types of Al

perform tasks, I speech and image
recognition, by exposing multi-
layered neural networks to vast
amount of data.

Artificial Intelligence is of two types- Weak Al and Strong Al.

Weak Al

Strong Al

Weak Al also known as narrow Al, is artificial
intelligence with limited functionality.

Strong Al is widely used, and the scope is
vast.

It is good at specific tasks.

It has incredible human-level intelligence.

Weak Al wuses advanced algorithms to
accomplish specific problem-solving or
reasoning tasks that do not encompass the full
range of human cognitive abilities.

Strong Al has a complex algorithm that
helps systems act in different situations,
and strong Al-powered machines can
make independent decisions without
human interaction.

Examples: Alexa, Siri

Examples: Automation, Robotics.
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COMPONENTS OF Al
COMPONENTS OF ARTIFICIAL INTELLIGENCE

Problem
Solving

Learning Reasoning

Language-

Perception .
P understanding

Learning:

The learning stage is the first stage in the growth process of artificial intelligence, just
like it is for humans. For instance, when training a child to ride a bike for the first time,
there will be a trial-and-error process during which the child will make mistakes and
fall off their bike while progressively learning the guidelines and methods required to
perform the task at hand. Learning is an essential part of AI and happens in several
different forms. The simplest form of learning is by trial and error. The solution keeps
on solving problems until it comes across the right results. The programme maintains
track of all the movements that resulted in success and stores it in its database to use
the next time the computer is given the same problem.

The learning component of Al includes memorising individual items like different
solutions to problems, vocabulary, foreign languages etc., also known as rote learning.
This learning method is later implemented using the generalisation method.

Reasoning:

Up until around 50 years ago, only humans could practise the art of reasoning. The
reasoning is one of the fundamental components of artificial intelligence since it can
differentiate and draw conclusions as well as inferences from the situation. These
inferences can also be classified as deductive or inductive. Deductive reasoning is in
which the truth of the premise guarantees the truth of the conclusion. In contrast,
in the case of inductive reasoning, the truth of the premises supports the conclusion,
but it cannot be fully dependent on the premises. In programming logic, generally,
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deductive inferences are used. Reasoning involves drawing inferences that are relevant
to the given problem or situation.

Problem-solving:

Problem-solving is possibly the most important aspect in the development of artificial
intelligence because the fundamental premise of Al is the development of computer
programmes and systems that handle issues in a manner comparable to that of humans.
The problem-solving component in Al allows the programs to include step-by-step
reduction of the difference, given between any goal state and the current state.

Perception:

In using the ‘perception’ component of Artificial Intelligence, the element scans any
given environment using different sense-organs, either artificial or real. To provide a
real-world application of perception in terms of artificial intelligence, many self-driving
cars function through the perception of different &
physical objects within a given environment, ranging
from traffic lights, weather conditions, buildings, and What is the literal meaning of

highways and roads, just to name a few. perception?

Gt Let me Answer

Language Understanding:

Natural Language Processing involves machines or robots to understand and process
the language humans speak and infer knowledge from the speech input. Al is developed
to easily understand the most commonly used human language, English. This way,
the platform allows the computers to understand the different computer programs
executed over them easily.

&, = Do You Know?

Application of Al

SHRDLU was one of the first AI programs to

AT has been dominant in various fields
understand natural language.

such as -

Gaming: In strategic games like tic-tac-toe, Minecraft, chess, and others, Al is essential
because it allows machines to generate many potential outcomes based on their heuristic
knowledge.

Health Care: Diagnoses of conditions like cancer, diabetes, and cardiovascular problems
have been made with success using AI. Also, Al has been playing a very crucial role in
identifying the right medicine for different disorders.

Customer Support: Worldwide, businesses and organisations invest a significant
amount of money on customer care and put in a lot of effort to give their clients ongoing
assistance. Many companies have built chatbots to provides customer support that use
Natural Language Processing to answer questions about their products and services.
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4. Banking and Financial Systems: Banks and other financial organisations create
Smart Apps to assist consumers with check deposits, fraud detection, etc., using Al
technologies.

5. Space Research: Artificial intelligence facilitates satellite communications and extracts
the maximum value from the images, increasing our understanding of space.

Al Around Us

AT was developed to improve our daily tasks and makes life easier. Let us look at artificial
intelligence that we see around us.

Voice Assistant

A voice assistant is a kind of AI software that can comprehend and carry out human spoken
orders. Examples: Google Assistant, Cortana, Siri and Alexa.

. Figure 8. 1 Siri and Alexa
Face Detection

Face detection is an AI technology used for various purposes. We use face detection for
filters on the face while taking pictures and face ID for unlocking the phone.

. . Figure 8. 2 Face ID
Navigation

Navigation apps use Al to update a commuter about traffic congestions in a particular area
and the estimated time to reach a particular destination. Also, it recommends the best route.
Example: Google Maps.
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Figure 8. 3 Google Maps

Robots

Robots are machines that run independently and take the place
of humans at work. They do not look like humans by appearance
nor perform exactly like humans. They use Al and can do many
tasks.

For example: Vaccum Robot, Robot Waiter and much more. ,
Figure 8. 4 Vaccum Robot

- = Kids’ 1Q

Name a few popular apps that make use of Al

@ Let’s Recall

The intelligence demonstrated by a machine is known as Al

« Artificial Intelligence is of two types- Weak Al and Strong Al

o Al can understand human language with the help of a concept called Natural
Language Processing.

o Weak Al is also known as narrow Al

o A voice assistant is a kind of AI software that can comprehend and carry out
human spoken orders.

o Al systems are efficient enough to reduce human efforts in various areas.
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A. Fill in the blanks.

1.

2.

The intelligence demonstrated by a machine is known as .................... :
A subset of artificial intelligence is ..........c.c.ccccocoeee :

Artificial intelligence is of two types ...........c.cc........ and ... :
The learning stage is the ....................... stage in the growth process of

artificial intelligence.

......................... are machines that run independently and take the place
of humans at work.

B. Write T for True statements and F for false statements.

Ll

5.

Strong Al is also known as narrow Al
Artificial intelligence is almost identical to humans.
Alexa and Siri are examples of weak Al

Al is developed to easily understand the most commonly used
human language, English.

Ju gud

AT can identify the right medicines for different disorders.

C. Answer the following in one word.

1.

Component of artificial intelligence which involves machines to process
the human language. ( ]

One of the first Al programs to understand the natural language.

[ J

The most important aspect in the development of artificial intelligence.
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4.

5. Al technology which uses face ID for unlocking the phone.

An Al software that can comprehend and carry out human spoken

orders. (

)

J

D. Answer the following questions.

1.  What do you mean by artificial intelligence?

) Dl ﬁere ntlatebe twee n Weak AI and Stro ng AI ............................................

5 Name thecomponents of AriclItclgence Eplinny v,

L Hiow AL usd in many orgisations o usomer sopor?

) erteanth 0 apphcatl OnSOfAIaroundus ...............................................
Computer6 .......... =::iiEi??ix-




/. #\ Critical Thinking
Y
Read the following conversation carefully and fill the gaps.

Hey guys, what are you talking about?

We have reached the location by using since we
didn’t know the route.

We were able to control the using and did
not have to type down manually. I say that Al is being used here but
Sandeep disagrees.

Ria is correct. Al is being used by the assistant here.

Team Work

AI might become more prevalent in schooling in the near future. How
will AI aid to enhance the teaching and learning process? In the space
provided here, write down what you know.
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= INTERNET SERVICES AND

CYBER SECURITY

Learning Outcomes

At the end of this lesson, students will be able to:
+ Know about internet services.

+ Learn netiquettes.

+ Understand the cyber threats.

Look at the pictures given below and identify the icons of the app. Fill in
appropriate colours in the logos.

Figure 9. 1 Firefox black n white logo Figure 9. 2 Opera black n white logo

) )
y

Figure 9. 3 Internet Explorer black n white logo Figure 9. 4 Google Chrome Black n white logo

C ) L)

‘g5 Teacher’s _ . o _
‘ J ([T Guide students that life today is highly dependent on computers, but it would have never
2\ been so popular and widely used if it was not for the Internet.
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Hello Friends!! In the previous class,
we learnt how to access the internet.
In this chapter, we will learn about
Internet services and cyber threats in
detail.

Internet is the interconnection of a large number of computer networks all over the world.
The internet plays an important role to make our life simple. It has revolutionised the world
and made it into a global village. In a couple of seconds, information can be shared with a
person anywhere around the globe.

Internet is also used for a variety of services including communication, shopping, banking
and much more.

Internet Services

We may carry out various operations on the Internet. Further, the Internet allows us to
access different types of data such as text, images, audio, video and software.

Let us know about some of the Internet Services in detail. L PR o0

For what purpose do you use
Internet?

Communication

The internet is currently the most widely used form
of communication. The rise of the internet has made communicating with others much
simpler. Apart from sending e-mails, you can talk to others almost face to face over the
Internet. You only need to click once to share your opinions, thoughts, videos etc. with your
friends.

Let us know about some of the ways used for communication over the Internet.
E-mail

E-mail stands for electronic mail. Messages can be sent and received from one computer to
another through the Internet. E-mail can be sent anytime during the day, anywhere in the world
and to many people simultaneously. Yahoo Mail and Gmail are some of the popular e-mail
service providers. If you already have an email account, simply log in to receive and send e-mails.
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Figure 9. 5 Inbox of Gmail

Video Conferencing

To communicate with your friends and family, you use phones and mobile devices. With the
development in technology, the person with whom you are talking can be seen as well. This
online technology which allows users in different locations to hold face-to-face meetings
without having to move to a single location together is called video conferencing. In video
conferencing, two or more people can speak to each other simultaneously over audio and
video from different locations. The basic requirement for video conferencing is a connection
to the Internet. In addition to this, you need to have a microphone and a webcam connected
to your computer or laptop.

Video conferencing is a fantastic technology. Companies with multiple offices might
establish direct video communications between their locations in order to allow their teams
to work more collaboratively. It has promoted e-learning as knowledge of teachers and
lecturers living in cities can be brought to remote areas. Surgeons in the medical industry
can supervise operations taking place in various parts of the world from their own hospitals.

Voice-Over-Internet Protocol (VoIP)

VoIP is the transmission of voice and multimedia content over an internet connection.
It is basically used for voice communications. It is available on smartphones, personal
computers, laptops and other hardware devices that can access the Internet.

Skype and GoogleTalk are the most common and popular VoIP services.
Follow the given steps to use the VoIP service of Skype.

Steps:

1. To install Skype on your computer, go to www.skype.com website.
Download Skype.

Double-click on the Skype icon to start Skype.
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4. 'To create an account on Skype, click on the Sign In or Create button to open the Sign
In screen.

REMEMBER IT!
Figure 9. 6 Creating an Account on Skype Sky peer-to peer is the

original name of skype.

5. Click on Create one! link. The create account screen appears.

6. Enter your email and click on the Next button.

7. Enter a password and click on Next.

8. Upload your personal details if you wish to and then click on the Continue button.

9. Further, skype asks you to check the webcam and microphone. Click on continue and
the Skype Welcome screen appears.

Figure 9. 7 Skype Welcome Screen
10. Click on the Contacts tab to add your contacts to the Skype account.

11. Inthe Add a new contact dialog box, enter the Skype ID of your friends.
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Figure 9. 8 Add a new Contact Dialogue

12. Select the desired person from the contacts tab to make a call.
13. Click on the call button to make a voice call to the person.

14. Click on the video call button to make a video call to the person.

SOCIAL NETWORKING

A social networking website provides a forum for connecting individuals who share
similar hobbies or interests. It allows you to share your views, ideas and suggestions. With
your contacts and friends, you may also share audio, video and still pictures. Some social
networking sites let you create groups that share a common interest.

Facebook, Tumblr, Instagram and Twitter are some of the most common Social Networking
sites. These are also used as a marketing hub. On these websites, there are a large amount
of knowledge and information is shared from across the world. However, these services are
typically viewed as a way for students to divert attention away from their studies. So, we
should use these sites wisely.

Figure 9. 9 Facebook site and Instagram site
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E-Greetings

E-greetings are identical to conventional cards in every way. The only distinction is the use
of digital text and effects to generate it. E-greetings are in soft copy, whereas paper greeting
cards are in hard copy. This means that you can see an e-greeting on your monitor but you
cannot touch it. E-greetings can be sent anytime through emails, saving paper and trees in
the way. An amazing e-greeting is created by the animation effects, music, still images and
text. Some of the popular e-greeting websites are www.egreetings.com, www.e-cards.com,
www.123greetings.com and more.

The recipient of an e-greeting must click on a link sent by the sender of the greeting in order
to view the e-greeting in his computer browser.

Figure 9. 10 www.123greetings.com

Let me Answer

E-Banking Have you ever sent an e-card
to anyone?

Money can be transferred online from one bank account
to another. Cheques were used in the past to transfer funds. The clearing of the cheques
takes two to three days. With e-banking, you can transfer funds easily from one account to
another through the computer, laptop and even your smartphone.

The United American Bank is thought to be the

Figure 9. 11 Netbanking pnb first bank in the world to offer computerised
banking at home.
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Advantages of E-banking

< Less time-taking

<*  Minimise paperwork

< Fewer chances of human errors

<* financial discipline and promotes transparency

Disadvantages of E-banking

< Lack of direct contact between customer and banking officer
< Security issues

<* Internet connectivity is a mandate

NETIQUETTES

The rules and standards that should be adhered to when meeting or conversing with others
are known as etiquettes. In online communication, there may be a situation when the
person may misunderstand your remark. A set of guidelines has been created to prevent
misunderstandings. This set of rules is known as netiquettes, which stands for Network
Etiquettes.

Some common netiquettes are:
< Use appropriate language.
< Avoid typing in capital letters as it can be interpreted as if you're shouting at the person.

<> Avoid using the “Reply To All” option when not necessary to answer everyone marked
in the email.

< Try to ignore the sender’s minor typing errors.
< The subject of the email must be in relation to the matter of the email.

< Avoid sending repeated emails just for publicity of the product or service.

Cyber Threats

A cyber threat is a malicious act that seeks to damage data, steal data, or disrupt digital life
in general. Most cyber threats are committed with the intention of making money:.
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Types of Cyber Threats

There are various types of cyber threats. Some of them are as follows:

Data Diddling

This kind of attack involves altering the raw data just before it is processed by a computer
and then changing it back after the processing is completed. For example, a student goes
through the school’s grade recording system and changes the grades of his half yearly exams,
hence increasing his grade point average.

Phreaking

The crime where hackers attack your voice network like they would (and do) attack your data
network. Instead of flooding your server with outbound emails, they flood your telephone
system with outbound calls. Your phone bill will cover the cost of those calls. This is an

exercise to create revenue for the hackers though, so they don't want you to know you have
been hacked.

Cloning

This refers to a fraud in which scanners are used to steal the electronic serial numbers
of cellular phones, which can be utilised for billing purposes and making broadcast calls.
Clones can be created to make free calls that are charged to the owner of the original cell
phone using the stolen serial numbers.

Carding

This refers to the process of stealing credit card numbers online, to be resold or used to
charge merchandise against the account of the victim.

Cracking

The term “cracking” means trying to get into computer systems in order to steal, corrupt, or
illegitimately view data. The persons who are involved in the process of cracking are called
crackers.

Software cracking is considered illegal and cracked software is often called pirated software.

Cyber Security

Cyber security is the practice of defending computers, servers, mobile devices, electronic
systems, networks, and data from malicious attacks. It's also known as information
technology security or electronic information security.
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Privacy and confidential information must be preserved and the system must be secured
against malicious theft or disturbance. Unfortunately, cybercrime is becoming more
prevalent worldwide.

The various reasons for increased cyber crimes are:

<> Not trained internet users
< Lack of awareness

<> Increased use of internet

L Kids’ 1Q

Should we share the one time password (OTP) with everyone?

Let’s Recall

o Internet is the interconnection of a large number of computer networks all
over the world.

e E-mail stands for electronic mail.

o Thetechnology which allows watching the person while talking is called video
conferencing.

o Skype and GoogleTalk are the most common and popular VoIP.
o E-greetings can be sent anytime through emails.

o Facebook, Tumblr, Instagram and Twitter are some of the most common
Social Networking sites.

o A cyber threat is a malicious act that seeks to damage or steal data.

o Cyber security is the practice of defending computers, servers, mobile devices,
electronic systems, networks and data from malicious attacks.
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A. Fill in the blanks.

| stands for electronic mail.

2. VoIP stands for ..o, .
3. The technology of watching the person while talking to him is called

4.  Netiquettes stands for ..o, :

S were used in the past to transfer funds.

B. Write T for True statements and F for false statements.
1. The Internet is currently the most widely used form of communication.| |
2. E-mail can be sent only during the day.

3. Gmalil is famous for video conferencing.

4

The most common VoIP services are Skype and GoogleTalk.

JUudy

5. We can create groups on social media networking sites.

C. Answer in one word.
1. A setof guidelines to be followed in online communication.

2.  Transmission of voice and multimedia content over an internet
connection.

3. A forum for connecting individuals who share similar hobbies or
interests.

4. Cards which use digital text and effects.

5. 'The most common social networking site.

D. Answer the following questions.

1. What do you mean by cloning?




2. What is cyber security?

Search any five internet services in the given grid.

A|H|E|B|A|N|K|I|N|G|O|TI]|P
R|B|C|A|S|D|F|G|O|H|J|K|L
D|F|D|E|C|V|B|N|M|A|P|V]S
clo/M|M|U|N|I|C|A|T|I|O|N
Q|E|E|A|R|T|Y|Y]|J|F|V]|I]|O
SID|F|I|G|O|H|F|G|K|L|P|D
Q/W|E|L|E|G|R|E|E|T|I|N|G
Team Work

Work in pairs. Sign up yourself with an e-greeting website such as
http://egreetings.gov.in and send an e-greeting to your partner.
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Fun Game

A set of instructions that tells
a computer how to input,
process and output data.

. . This tool allows automated lists
A collection of slides, arranged : .
and custom lists, to be easily

in a continuous manner.
added to a spreadsheet.

\ /

An app which updates commuter
about traffic congestions in a
paricular and about the estimated
to reach the destination.

Pre-designed formulas in Excel
to perform simple and complex
calculations.

1. Which patterned block will come in the fourth block?

Computer-6 =
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B X X




2. Which is the correct net to from the given cube?

i

3. Which number should be placed in the empty triangle?

AAAA
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B = Computer-6




